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MODUL I 

PENGENALAN GAME EDUKASI DAN SOFTWARE GAME MAKER 

 

 

 

Mahasiswa memahami game edukasi dan menyusun rencana pengembangan game 

edukasi, memahami jenis-jenis software game maker serta dapat melakukan  

analisis terhadap game edukasi yang sudah ada. 

 

 

Setelah mempelajari bab ini, mahasiswa:  

1. Mampu Mampu menjelaskan konsep game edukasi 

2. Mampu menyebutkan berbagai tools untuk pembuatan game edukasi 

3. Mampu melakukan analisis terhadap game edukasi yang sudah ada. 

 

 

1. Game Edukasi 

Game edukasi merupakan sebuah permainan yang dirancang untuk 

merangsang daya pikir termasuk meningkatkan konsentrasi dan memecahkan 

masalah. Game edukasi dapat digunakan untuk memberikan pengajaran dan 

menambah pengetahuan penggunanya dengan cara yang unik dan menarik. 

2. Jenis Game 

Berikut ini beberapa jenis game yang biasanya dimainkan di handphone 

atau komputer:  

a. Action Games 

Action game merupakan game dengan berbagai tantangan fisik, teka-teki 

atau puzzle, balapan, mengumpulkan benda-benda dan beberapa konflik 

lainnya. 

b. Real Time Strategy (RTS) 

Real Time Strategy merupakan game yang melibatkan masalah strategi, 

taktik dan logika. 

1.1 Tujuan Pembelajaran 

1.2 Capaian Pembelajaran 

1.3 Materi 
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c. Role Playing Games (RPG) 

Game jenis Role Playing Games merupakan permainan di mana 

pemainnya memainkan peran karakter dalam latar fiksi. Game ini 

melibatkan masalah taktik, logika dan eksplorasi atau penjelajahan. 

d. Real World Simulation 

Real World Simulation merupakan permainan yang mensimulasikan 

kegiatan di dunia nyata seperti permainan simulasi kendaraan, simulasi 

memasak dan lain sebagainya. 

e. Construction and Management 

Game jenis Construction and Management lebih menitikberatkan aspek 

manajerial. Biasanya game jenis ini mengangkat tema ekonomi dan 

konsep, seperti manajemen penjualan. 

f. Adventure Games 

Adventure game atau biasa disebut game petualangan merupakan game 

yang mengutamakan masalah eksplorasi dan pemecahan teka-teki. 

g. Puzzle Games 

Puzzle games ditujukan untuk memecahkan suatu masalah berkaitan 

dengan logika. 

h. Slide Rolling Games 

Pada jenis game ini karakter dapat bergerak kesamping diikuti dengan 

gerakan background. 

3. Software Pembuat Game 

Dalam dunia IT software pembuat game sangat banyak jenisnya. Ada 

game engine yang dikhususkan diplatform tertentu atau untuk semua perangkat 

platform (Multiple Platform). Berikut ini merupakan beberapa contoh software 

pembuat game. 

a. Game Maker 

b. Construct 2 

c. RPG Maker 

d. Cocos 2D 

e. Game Salad 
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f. Monogame 

g. Unity 

h. Stencyl 

i. Adventure Maker Studio 

j. Corona SDK 

 

 

 

1. Carilah informasi mengenai beberapa software pembuat game dan tuliskan 

informasi mengenai kelebihan dan kekurangannya! 

2. Carilah contoh aplikasi game edukasi, kemudian lakukan analisis terhadap 

game edukasi tersebut. 

  

1.4 Tugas 
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TTD Dosen/Asisten & Tanggal  
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MODUL II 

MEMBUAT GAME PUZZLE 

 

 

Membuat sebuah game puzzle dengan Unity. 

 

 

Mahasiswa mampu membuat sebuah game puzzle dengan Unity untuk sebuah 

materi pembelajaran. 

 

 

Langkah Membuat Game Puzle adalah sebagai berikut: 

1. Buat project baru 2D dengan nama Gpuzzle, serta pilih lokasi untuk 

menyimpan game tersebut. 

2. Klik create project. 

3. Tunggu sampai proses selesai, jika sudah selesai akan muncul tampilan 

seperti berikut. 

 

4. Klik kanan Assets → Import New Assets. 

2.1 Tujuan Pembelajaran 

2.2 Capaian Pembelajaran 

2.3 Materi 



6 

 

 

5. Pilih file-file pendukung yang diperlukan → Import. 

 

6. Buatlah Scene baru dengan klik kanan Assets→ Create → Scene. 

 

7. Ubah nama scene menjadi puzzle. 

 

8. Klik 2x pada scene puzzle yang telah dibuat, masukkan gambar kebun 

kedalam scene puzle dan letakkan di bawah main camera seperti pada 

gambar di bawah. 
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9. Sesuaikan scale gambar kebun dengan main camera. 

 

10. Buatlah objek baru dengan cara klik kanan pada bagian yang diberi tanda 

→ Create Empty. 

 

11. Kemudian ubah namanya menjadi konten. 

Klik kanan 

--> Create 

Empty 
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12. Potong gambar gajah dan kucing menjadi potongan-potongan puzzle 

terlebih dahulu dengan cara klik gambar gajah lalu ubah sprite mode 

menjadi multiple. 

 

13. Klik sprite editor→ Apply. 

 

14. Kemudian akan muncul tampilan seperti berikut. Klik slice→ slice dan 

tunggu beberapa saat.  
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15. Klik salah satu potongan gambar gajah, maka dia akan terpotong otomatis 

→ pilih Apply di bagian kanan atas lalu close. 

 

16. Sebelum memasukkan potongan-potongan puzzle ubah position Z kebun 

menjadi 5 agar background kebun tidak menutupi puzzle seperti gambar. 

 

17. Masukkan semua potongan-potongan puzzle gajah kedalam objek konten 

dengan cara drag and drop gambar ke dalam objek konten. 
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18.  Susun puzzle menjadi gambar gajah yang utuh, kemudian seleksi semua 

gambar gajah dan kecilkan sesuai ukuran yang diinginkan. 

 

19. Buat objek baru di dalam konten dengan nama puzzle1 seperti gambar 

berikut, kemudian select semua gambar puzzle gajah dan drag pindahkan ke 

dalam puzzle1. 
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20.  Seleksi semua gambar puzzle gajah_1-6 kemudian duplikat semua 

gambar puzzle dengan ctrl+D dan letakkan di sebelah kanan. 

 

21. Ubah semua nama gambar puzzle disebelah kanan menjadi seperti gambar 

di bawah. 

 

22. Ubah color semua posgajah_1-6 menjadi hitam. 

 

23. Buat objek pada gambar posgajah_1 dengan nama detect1 dengan cara 

klik kanan posgajah_1→ Create Empty. 
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24. Tambahkan box collider 2D pada detect1 dengan cara Add 

Component→ box collider 2D. 

 

25. Tambahkan rigidBody 2D pada detect1 dengan cara Add Component→ 

rigidBody 2D. Ubah body type menjadi kinematic dan aktifkan freeze 

rotation. Atur juga position Z menjadi -1. 
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26. Duplikat detect1 menjadi detect2, detect3,dan seterusnya sampai detect6. 

Kemudian masukkan ke dalam masing-masing posgajah sesuai urutan 

misal detect2 ke dalam posgajah_2, detect3 ke dalam posgajah_3 dan 

seterusnya. 

 

27. Atur position setiap detect1-6 menjadi x = 0, y = 0 dan z = -1. 
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28.  Kecilkan ukuran gajah_1 sampai gajah_6. 

 

29. Tempatkan potongan puzzle gajah_1 sampai gajah_6 secara acak. 

 

30. Seleksi gajah_1 sampai gajah_6 kemudian tambahkan box collider2D 

dengan cara add component→ box collider2D. 
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31. Kemudian Checklist is trigger. 

 

32. Agar gajah_1 sampai gajah_6 dapat di drag, maka kita perlu memasukkan 

script dengan cara klik kanan Assets → create → C# Script . 

 

33. Ubah nama script menjadi drag. Untuk membuka script cukup klik 2x pada 

script yang ingin di edit atau dibuka. 

 

34. Ketikkan script berikut ini pada script drag. 
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using System.Collections; 

using System.Collections.Generic; 

using UnityEngine; 

 

public class drag : MonoBehaviour 

{ 

    public GameObject detector; 

    public Vector3 pos_awal, scale_awal; 

    public bool on_pos = false, on_tempel= false; 

    // Start is called before the first frame update 

    void Start() 

    { 

        pos_awal = transform.position; 

        scale_awal = transform.localScale; 

    } 

 

    void OnMouseDrag(){ 

       Vector3 pos_mouse = Camera.main.ScreenToWorldPoint(new

 Vector3(Input.mousePosition.x, Input.mousePosition.y, Input.

mousePosition.z)); 

        transform.position = new Vector3(pos_mouse.x, pos_mou

se.y, -1f); 

        transform.localScale = new Vector2 (0.4f, 0.38f); 

 

    } 

 

    void OnMouseUp(){ 

        if(on_pos){ 

            transform.position = detector.transform.position; 

            transform.localScale = new Vector2 (0.4f, 0.38f); 

            on_tempel= true; 

        }else{ 

            transform.position =pos_awal; 

            transform.localScale =scale_awal; 

            on_tempel= false; 

        } 

    } 

    void OnTriggerStay2D(Collider2D objek){ 

        if (objek.gameObject == detector){ 

            on_pos=true; 

        } 

 

    } 

    void OnTriggerExit2D(Collider2D objek){ 

        if (objek.gameObject == detector){ 

            on_pos=false; 

    } 

} 

    // Update is called once per frame 

    void Update() 

    { 

    }} 

Sesuai ukuran scale pada 

posgajah_1 sampai posgajah_6 
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35. Masukkan script drag ke dalam gajah_1 sampai gajah_6 dengan cara klik 

gajah_1 kemudian drag sript drag  dan letakkan di bawah box colider2D 

gajah_1. 

 
36. Setelah itu masukkan detector pada drag sript sesuai dengan detect masing-

masing dengan cara drag detect1 ke dalam detector drag script gajah_1 

ulangi sampai gajah_6. 

 
37. Untuk membuat feedback pada game puzzle ini, masukkan gambar senang 

sebagai feedback, letakkan di bawah konten. 

Drag and drop 

Drag and drop 
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38. Posisikan gambar senang seperti berikut. Ubah position Z menjadi -1. 

 
39.  Buat animasi gambar senang dengan cara Klik gambar senang → 

windows → animation → animation (ctrl+6). 

 
40. Selanjutnya akan muncul tampilan seperti dibawah ini. Pilih create untuk 

membuat animasi. 
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41. Berikan nama animasi menjadi senang → save. 

 
42. Kemudian akan muncul tampilan seperti ini dan  pilih add property → 

transform → klik tanda + pada position. 

 
43. Setelah muncul tampilan berikut kemudian klik satu kali pada tanda 

kristal sehingga berubah warna menjadi biru dan tarik garis putih 

dengan posisinya tepat di kristal berwarna biru. Setelah itu klik 

lingkaran berwarna merah untuk enable/disable keyframe. 

 
44. Geser gambar senang ke sebelah kiri keluar dari background. 
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45. Klik windows → animation → animator. 

 
46. Selanjutnya muncul tampilan animator seperti berikut. Klik 2x animasi 

senang dan hilangkan ceklis loop time. 

 
47. Tambahkan C# script dengan cara seperti sebelumnya assets → create → 

C# script → beri nama feedback, kemudian ketikkan script berikut ini: 

using System.Collections; 

using System.Collections.Generic; 

using UnityEngine; 

 

public class feedback : MonoBehaviour 

{ 

     public GameObject senang; 

    bool selesai= false; 

 

    // Start is called before the first frame update 

    void Start() 

    {   

    } 
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    public void cek(){ 

        for(int i =0; i< 6 ; i++){  

            if(transform.GetChild(i).GetComponent<drag>().on_

tempel){ 

                selesai=true; 

            }else{ 

                selesai=false; 

                i= 6 ; 

            } 

        } 

        if(selesai){ 

            senang.SetActive(true); 

            selesai=false; 

        } 

    } 

    // Update is called once per frame 

    void Update() 

    { 

        if(!selesai){ 

            cek(); 

        } 

         

    }}} 

 

 

48. Masukkan script feedback ke dalam puzzle1 dengan cara drag and drop 

script seperti langkah sebelumnya. 

 
49. Drag and drop senang ke dalam scrip feedback. 

Drag and drop 

Sesuai jumlah 

potongan puzzle 
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50. Klik gambar senang kemudian hilangkan ceklis seperti berikut. 

 
51. Masukkan audio pada feedback agar lebih menarik dengan cara klik add 

component → audio source. 

 
52. Drag and drop audio goodjob ke dalam audioclip. 

 
53. Setelah itu kita buat tombol reset dengan cara masukkan gambar reset 

sebagai objek reset dan letakkan di bawah objek senang. Sesuaikan ukuran 

yang diperlukan dan letakkan di sebelah kiri bawah seperti gambar berikut. 

Drag and drop 

Drag and drop 
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54. Tambahkan circle collider2D dengan cara add component→ circle 

collider2D. 

 
55. Buat C# Script dengan nama reset dan ketikan script berikut ini: 

using System.Collections; 

using System.Collections.Generic; 

using UnityEngine; 

 

public class reset : MonoBehaviour 

{ 

    public GameObject parent_puzzle, senang; 

 

    // Start is called before the first frame update 

    void Start() 

    { 

         

    } 

 

    void OnMouseUp(){ 

         for(int i =0; i< 6; i++){ 

        parent_puzzle.transform.GetChild(i).GetComponent<drag

>().on_tempel = false; 

        parent_puzzle.transform.GetChild(i).GetComponent<drag

>().on_pos = false; 
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        parent_puzzle.transform.GetChild(i).position = parent

_puzzle.transform.GetChild(i).GetComponent<drag>().pos_awal; 

        parent_puzzle.transform.GetChild(i).localScale = pare

nt_puzzle.transform.GetChild(i).GetComponent<drag>().scale_aw

al; 

    } 

    senang.SetActive(false); 

    } 

    // Update is called once per frame 

    void Update() 

    { 

         

    }} 

56. Masukkan script reset kedalam objek reset dengan cara drag and drop 

seperti langkah sebelumnya. 

 
57. Drag and drop puzzle1  kedalam parent_pazzle, dan objek senang kedalam 

script senang. 

 
58. Tambahkan tombol next dan back letakkan di bawah objek reset. Atur 

posisi tombol di sebelah kiri bawah. 

Drag and drop 

Drag and drop 
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59. Pindahkan objek reset kedalam puzzle1. 

 
60. Duplikat puzzle1 dan ubah nama menjadi puzzle2 untuk membuat puzzle 

hewan selanjutnya yaitu kucing.  

 
61. Sebelum membuat puzzle2 sembunyikan terlebih dahulu puzzle1 dengan 

cara hilangkan checklist dari puzzle1. 
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62. Untuk membuat puzzle2, lakukan langkah-langkah seperti membuat 

puzzle1 diatas sehingga hasilnya seperti berikut: 

 
63. Langkah berikutnya yaitu membuat tombol back dan next. Seleksi objek 

back dan next, kemudian tambahkan box collider2D dengan cara add 

component → box collider2D. 
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64. Langkah selanjutnya yaitu membuat C# sript untuk script tombol back 

dan next, berikan nama control. Kemudian ketikan script berikut: 

using System.Collections; 

using System.Collections.Generic; 

using UnityEngine; 

 

public class control : MonoBehaviour 

{ 

    public GameObject parent; 

 

    // Start is called before the first frame update 

    void Start() 

    { 

         

    } 

 

    int urutan= 0; 

 

    void aktif(){ 

        urutan +=a; 

        if(urutan<0){ 

            urutan=parent.tranform.childCount-1; 

        }else if(urutan> parent.tranform.childCount-1){ 

            urutan=0; 

        } 

        for(int i=0; i< parent.tranform.childCount; i++){ 

            parent.tranform.GetChild(i).gameObject.SetActive(

false); 

        } 

        parent.tranform.GetChild(urutan).gameObject.SetActive

(true); 

    } 

 

    void OnMouseUp(){ 

        if(gameObject. name == "next"){ 
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            aktif(1); 

        }else{ 

            akif(-1); 

        } 

    } 

    // Update is called once per frame 

    void Update() 

    {   

    } 

} 

 

65. Kemudian seleksi tombol back dan next dan masukkan script control 

kedalamnya dengan menggunakan drag and drop seperti langkah-langkah 

sebelumnya. 

 
66. Drag and drop objek konten ke dalam parent. 

 
67. Game puzzle selesai, untuk menjalankan klik play. 

Drag and drop 
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68. Game siap dimainkan. 
 

 

 

Buatlah sebuah game puzzle untuk suatu materi pembelajaran dengan Unity. 

  

2.4 Tugas 
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Lembar Jawab 

Nama : 

NPM : 

No: Tanda tangan : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

TTD Dosen/Asisten & Tanggal  
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MODUL III 

GAME HITUNGAN MATEMATIKA 

 

 

 

Membuat game hitungan matematika.  

 

 

Mahasiswa mampu membuat game hitungan matematika dengan Unity untuk 

sebuah materi pembelajaran. 

 

 

Langkah Membuat Game Hitungan Matematika adalah sebagai berikut: 

1. Buat project baru 2D dengan nama game kuis, serta pilih lokasi untuk 

menyimpan game tersebut. 

 
2. Masukkan semua asset file yang dibutuhkan dengan cara klik kanan assets→ 

import new assets. 

 
3. Buat folder baru dan beri nama scene dan animasi, lakukan dengan cara klik 

kanan assets→create→folder. 

3.1 Tujuan Pembelajaran 

3.2 Capaian Pembelajaran 

3.3 Materi 
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4. Masuk dalam folder scene dengan cara klik 2x folder scene dan buat scene baru 

dengan cara klik kanan assets → creat → scene beri nama main. 

 
5. Klik 2x scene main, sebelumnya kita masuk ke dalam folder gambar dan kita 

slice gambar terlebih dahulu. Lakukan dengan cara klik gambar assets → ubah 

sprite mode menjadi multiple → sprite editor → apply. 

 
6. Setelah muncul tampilan sprite editor klik slice → slice → klik salah satu 

gambar → apply → close. 
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7. Gunakan canvas pada scene main dengan cara klik kanan daerah scene main →  

UI→ canvas. 

 
8. Agar ukuran canvas sesuai dengan ukuran camera maka ubah render mode → 

screen space- camera. 

Klik kanan 
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9. Masukkan main camera ke dalam render camera dengan cara drag and drop, 

kemudian ubah lagi render mode menjadi world space. 

 
10. Klik kanan canvas → UI → image untuk menambah gambar. 

 
11. Pada image masukkan bg (background) ke dalam source image dengan cara 

drag and drop. 
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12. Sesuaikan background dengan ukuran main camera dan ubah nama image 

menjadi bg (background). 

 
13. Seperti langkah sebelumnya buat image di dalam canvas dengan cara klik 

kanan canvas→ UI→ image→ masukkan gambar kuis matematika ke dalam 

source image dengan cara drag and drop→ ubah nama image menjadi judul. 

 
14. Selanjutnya membuat tombol play dengan cara klik kanan canvas→ UI→ 

Button→ ubah nama dengan play→ klik objek play→ delete text yang ada 

di dalamnya. 

Drag and drop 
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15. Masukkan gambar play (assets_0) ke dalam source image dengan cara drag and 

drop, dan sesuaikan ukurannya. 

 
16. Buat folder baru dengan nama script. 

 
17. Di dalam folder script , buat script baru dengan cara klik kanan halaman 

script→ create → C# script. Kemudian ketikkan script berikut: 

using System.Collections; 

using System.Collections.Generic; 

using UnityEngine; 

 

public class tombol : MonoBehaviour 

{ 

    // Start is called before the first frame update 

    void Start() 

    {  

    } 

Drag and drop 
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    public void scale(float scale){ 

        transform.localScale = new Vector2 (1/scale,1*scal

e); 

    } 

    public void scene( string scene){ 

        Application.LoadLevel(scene); 

    } 

    // Update is called once per frame 

    void Update() 

    {  

    } 

} 

 

18. Kemudian masukkan script tersebut ke dalam tombol play dengan cara drag and 

drop. 

 
19. Tambahkan event trigger di dalam tombol play dengan cara add component→ 

event trigger. 

 
20. Tambahkan PointerDown di dalam event trigger dengan cara add new evet 

type→ PointerDown dan PointerUp. 

Drag and drop 
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21. Klik tanda + dan masukan play ke dalam pinterDown dan pointerUp dengan 

cara drag and drop objek play. 

 
22. Ubah PointerUp dan pointerDown kita ubah menjadi tombol. Scale dengan cara 

klik no function → tombol→ scale (float). 
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23. Ubah ukuran pada pointerDown menjadi 0,8 sedangkan pointerUp menjadi 1. 

 
24. Buat scene baru di dalam folder scene kita dengan menduplikat scene main dan 

ubah namanya menjadi game. 

 
25. Sebelum beralih ke dalam scene game, klik objek play pada scene main 

kemudian klik tanda + pada pointerUp→ drag and drop objek play seperti 

langkah sebelumnya→ klik no function→ tombol → scene (string). 
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26. Masukkan scene yang akan dituju yaitu scene game. 

 
27. Masukkan scene game dan scene main ke dalam build setting file → build 

setting→ drag and drop game dan main ke dalam build setting → close. 

 

Drag and drop 
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28. Kemudian masuk kedalam scene game, hapus objek judul dan play. Tambahkan 

objek baru di dalam canvas dengan cara klik kanan canvas→ create empty→ 

ubah namanya menjadi gameplay. 

 
29. Dalam gameplay tambahkan image, klik kanan objek gameplay → UI → image 

→ ganti source image dengan gambar assets_15 sebagai background soal 

menggunakan drag and drop. 

 
30. Sesuaikan ukuran gambar assets_15, kemudian ubah namanya dari image 

menjadi bg (background). 

 
31. Di dalam gameplay tambahkan image, klik kanan objek gameplay → UI→ 

image → ganti source image dengan gambar assets_12 sebagai judul soal 

dengan menggunakan drag and drop kemudian sesuaikan posisi gambar judul. 
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32. Ubah nama objek dari image menjadi judul. 

 
33. Tambahkan objek baru di dalam gameplay. Klik kanan gameplay → create 

empty → ubah nama menjadi bank_soal. Tambahkan text dalam bank_soal, 

klik kanan bank_soal→ UI → text → ubah nama menjadi soal. Kemudian 

sesuaikan posisinya. 

 
34. Ubah jenis font menjadi JandaManteeSolid yang ada di dalam folder font 

dengan cara drag and drop dan masukkan kedalam jenis font. Buat text menjadi 

rata tengah dan ukuran text menjadi 48. 
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35. Untuk menginputkan jawabannya masukkan input field. Klik kanan 

bank_soal→ UI → input field → ubah nama menjadi input jawaban→ dan 

source image ubah dengan gambar asset_6 dengan cara drag and drop gambar. 

Kemudian sesuaikan tempatnya. 

         
36. Klik input jawaban→ placeholder→ubah text menjadi “Masukkan Jawaban”. 

 
37. Klik input jawaban→ ubah content type menjadi integer number. 

Drag and drop 
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38. Tambahkan button pada bank soal dengan klik kanan bank_soal → UI→ 

Button→ ubah nama menjadi jawab→ klik jawab kemudian hapus text yang 

ada di dalamnya → ubah source image dengan gambar jawab (assets_9). 

Kemudian atur posisinya sesuai keinginan. 

 
39. Buat objek baru di dalam objek canvas, klik kanan objek canvas → create 

empty→ ubah namanya menjadi feed (sebagai feedback). Tambahkan image di 

dalam feedback, klik kanan feed→ UI → image → ubah nama menjadi benar 

(sebagai feedback benar), tambahkan image lagi di dalamnya dan ubah 

namanya menjadi salah (sebagai feedback salah). 
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40. Ubah source image pada image benar dengan drag androp assets_2. Begitu juga 

pada source image salah dengan drag and drop assets_1. 

 
41. Atur posisi feedbacknya. 

 
42. Setelah itu buat animasi feedback dengan klik image salah→ windows → 

animation→ animation (ctrl+6), maka akan muncul tampilan seperti berikut 

dan klik create. 
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43. Simpan animasi di game kuis → assets → animasi, ubah namanya menjadi feed 

→ save. 

 
44. Kemudian klik add properti→ recent transform→ klik tanda + ancored 

position. 

 
45. Klik key frame sehingga berubah menjadi warna biru, kemudian geser ke kanan 

image salah dan klik lingkaran merah. 
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46. Letakkan garis putih yang akan digunakan untuk key frame selanjutnya dan buat 

lagi key frame dengan cara klik 2x dan tarik lagi gambar ke kiri. 

 
47. Buat lagi key frame dan tarik gambar sedikit ke kanan. 

 
48. Ctrl + c key frame, kemudian tarik garis putih sedikit jauh dari key frame ketiga 

kemudian Ctrl + v. 
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49. Untuk key frame terakhir geser gambar ke kanan keluar dari background. 

 
50. Kemudian klik windows → animation → animator → klik 2 x animasi feed 

(kontak berwarna oranye) → hilangkan check list loop time. 
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51. Untuk menambah animasi pada feedback benar, karena animasinya kita buat 

sama dengan animasi pada feedback salah, maka kita hanya perlu 

menambahkan animator pada feedback benar dengan cara klik benar → add 

component → animator → kemudian klik tanda lingkaran pada controller, 

maka akan muncul tampilan select runtimecontroler → kemudian klik animasi 

salah 2x. 

 
52. Untuk membuat skor kita tambahkan image di dalam canvas, kemudian ubah 

namanya menjadi skor, pada source image masukkan gambar skor (assets_10), 

kemudian atur posisinya sesuai keinginan. 

 
53. Di dalam skor maskukkan teks dengan klik kanan skor → UI→ text, kemudian 

atur textnya seperti cara yang sebelumnya yaitu memasukkan jenis huruf 

dengan drag and drop font, kemudian beri warna dengan warna putih atau sesuai 

keinginan. Huruf dibuat rata tengah. 



50 

 

 
54. Untuk membuat notifikasi bahwa game selesai, buat image baru di dalam 

gameplay letakkan di bawah objek judul → ubah namamanya menjadi selesai 

→ ganti source image dengan gambar selamat semua soal telah terjawab 

(assets_11) → kemudian atur posisinya sesuai keinginan. 

 
 

 

55. Klik ctrl+6 untuk membuat animasi selesai → create→ beri nama selesai→ 

add property → rect transfrom →klik tanda + scale. 
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56. Buat 3 key frame dengan ukuran scale pertama ubah x dan y menjadi 0, 

kemudian pada key frame kedua ubah ukuran scale menjadi 1,1 dan key frame 

ketiga ubah ukuran scale x dan y menjadi 1. 

 
57. Kemudian buka animator dan matikan loop timenya. 

 
 

58. Sembunyikan terlebih dulu animasi selesai, dan animasi dari feedback benar 

dan salah dengan cara hilangkan ceklist dari selesai seperti gambar berikut 

(berlaku juga untuk feedback benar dan salah). 
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59. Untuk kembali ke menu utama atau home kita perlu membuat tombol back 

dengan menambahkan button di dalam canvas. Klik kanan canvas → UI → 

button → hapus text di dalam button dan ubah namanya menjadi back. 

Masukkan gambar back (assets_3) di dalam source image dengan drag and 

drop. Atur posisinya sesuai keinginan. 

 
60. Tambahkan script tombol dengan cara add component → tombol. 
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61. Klik add component → event trigger. 

 
62. Klik add new event type → tambahkan pointerUP dan pointerDown. 

 
63. Buat animasi tombol seperti pada animasi tombol play. Scene yang dituju 

adalah scene main. 
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64. Masuk ke dalam folder script dan buat script baru dengan nama gameplay. 

 
65. Ketikan script berikut pada script gameplay: 

using System.Collections; 

using System.Collections.Generic; 

using UnityEngine; 

using UnityEngine.UI; 

 

public class gameplay : MonoBehaviour 

{ 

    public string [] soal, jawaban; 

 

    public Text text_soal, text_skor; 

 

    public InputField input_jawaban; 

    public GameObject feed_benar, feed_salah, selesai, ban

k_soal; 

 

    int urutan_soal=-1, skor=0; 

    // Start is called before the first frame update 

    void Start() 

    { 

        tampil_soal(); 

    } 

 

    public void jawab(){ 
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        if(urutan_soal<soal.Length -1 ){ 

        if(input_jawaban.text == jawaban[urutan_soal]){ 

            feed_benar.SetActive(false);             

            feed_benar.SetActive(true); 

            feed_salah.SetActive(false); 

            skor+=20; 

        }else{ 

            feed_benar.SetActive(false);             

            feed_salah.SetActive(false); 

            feed_salah.SetActive(true); 

 

        } 

        input_jawaban.text =""; 

        tampil_soal(); 

    }else{ 

        selesai.SetActive(true); 

        bank_soal.SetActive(false); 

    } 

    } 

 

    void tampil_soal(){ 

        urutan_soal++; 

        text_soal.text = soal [urutan_soal]; 

    } 

 

    // Update is called once per frame 

    void Update() 

    { 

        text_skor.text = skor.ToString(); 

    } 

} 

 

 

 

66. Sebelum masuk ketahap selanjutnya pastikan text dari skor bernilai 0, jika 

belum ubah terlebih dahulu. 

 
67. Kemudian masukkan script gameplay yang tadi dibuat ke dalam objek 

gameplay dengan cara drag and drop seperti langkah-langkah sebelumnya. 

Agar soal selanjutnya langsung tampil 

setelah dijawab 

Input jawaban kosong setelah klik 

tombol jawab 
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68. Ubah size soal dan jawaban menjadi 5. 

 
69. Masukkan soal dan jawabannya. 

Drag and drop 
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70. Masukkan objek ke dalam variable script masing-masing dengan cara drag and 

drop. 

           
71. Pada tombol jawab berilah fungsi pada onClick dengan klik tanda + di dalam 

onClick dan masukkan objek gameplay. 
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72. Klik no function → gameplay → jawab(). 

 
73. Agar lebih menarik, tambahkan efek sound pertama masuk game ke dalam 

scene main. Untuk menambahkan sound pada scene main. Drag and drop sound 

main kemudian nyalakan loop pada audio source. 

 
74. Drag and drop sound touch, kemudian matikan check list play on awake. 

Drag and drop 

Drag and drop 
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75. Klik objek play → pada PointerDown klik tanda + kemudian drag and drop 

sound touch. 

 
76. Klik no function → audiosource → play(). 

 
77. Pada scene gameplay berikan sound gameplay dan sound tombol-tombol yang 

ada di scene gameplay. Lakukan dengan langkah-langkah yang sama seperti 

memberikan sound pada scene main dan tombol play pada scene main. 

Drag and drop 
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Selanjutnya berikan efek sound untuk feedback dengan klik feedback benar → 

add component→ audio source → masukkan sound benar kedalam audio clip 

dengan drag and drop. 

 
78. Lakukan hal yang sama untuk memasukkan sound pada feedback salah. 

Langkah yang sama juga pada animasi selesai. 

79. Game siap untuk dimainkan. 

 

 

Buatlah sebuah game hitungan matematika sesuai dengan kreasi masing-masing. 

  

3.4 Tugas  

Drag and drop 
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Lembar Jawab 

Nama : 

NPM : 

No: Tanda tangan : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

TTD Dosen/Asisten & Tanggal  
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MODUL IV 

GAME KUIS PILIHAN GANDA 

 

 

 

Membuat game hitungan kuis pilihan ganda.  

 

 

Mahasiswa mampu membuat game kuis pilihan ganda dengan Unity untuk sebuah 

materi pembelajaran. 

 

 

Langkah membuat game kuis pilihan ganda adalah sebagai berikut: 

1. Buat game 2D baru dan beri nama kuis pilgan. 

2. Import assets yang dibutuhkan. 

 
3. Buat scene baru dengan cara klik kanan assets → create → scene → ubah nama 

menjadi kuis. Kemudian klik 2x kuis untuk membuat kuis pilihan ganda. 

 
 

 

4. Masukkan background dengan drag and drop  kemudian sesuikan dengan 

ukuran kamera. 

4.1 Tujuan Pembelajaran 

4.2 Capaian Pembelajaran 

4.3 Materi 
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5. Buatlah canvas dan letakkan di bawah background dengan cara klik kanan→ 

UI→ canvas.  

 
6. Ubah render mode canvas menjadi world space → event camera menjadi main 

camera dengan klik lingkaran di samping event camera → klik scene → main 

camera. 

 

Drag and drop 
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7. Ubah pos Z pada canvas menjadi 0. 

 
8. Klik bgg → ubah position Z menjadi 5. 

 
 

9. Buat objek baru di dalam canvas klik kanan canvas → create empty → ubah 

nama menjadi soal_1. Tambahkan text di dalam soal_1 dengan Klik kanan 

soal_1 → UI→ text → ubah nama menjadi text soal. 

 
10. Tulislah pertanyaannya dan atur ukuran tulisan dan warnanya sesuai 

keinginan. 
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11. Di dalam soal buat tombol dengan klik kanan soal_1 → UI → button ubah 

namanya menjadi A (sebagai jawaban A). Kemudian ubah warna button agar 

lebih menarik. 

 
 

 

12. Di dalam button terdapat text, ubah isinya menjadi jawaban dari soal. 

 
13. Duplikat button jawaban dengan ctrl +D sehingga menjadi 4 button jawaban. 

Kemudian atur posisinya sesuai yang diinginkan. Ubah nama button. 
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14. Isikan text button dengan jawaban. 

 
 

 

15. Buat skor di dalam canvas dengan klik kanan canvas → UI → text → ubah 

nama label ( digunakan untuk label skor). Isikan text dengan skor. 

 
16. Duplikat label untuk dijadikan nilai dengan ctrl +D dan masukkan ke dalam 

label → ubah nama menjadi skor. 



67 

 

 
17. Buat objek kosong di bawah eventSystem dan beri nama feedback dengan klik 

kanan → create empty. Masukkan gambar feedback benar dan salah. 

 
 

18. Atur posisi feedback kemudian ubah position Z menjadi -1. 

 
19. Kemudian kita buat animasi feedback benar dengan ctrl +6 → create → 

berikan nama feedback pada animasi → save. 
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20. Kilk add property → transform → scale. 

 
21. Klik lingkaran merah kemudian tambahkan 2 keyframe baru di tengah pada 

keyframe pertama dan terakhir ubah scale X dan Y menjadi 0. 

 
22. Klik windows→ animation→ animator→ klik 2x animasi feedback→ hapus 

ceklist dari time loop. 
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23. Karena animasi pada feedback benar sama dengan animasi pada feedback salah 

maka tidak perlu lagi membuat animasi, tinggal menambahkan animator pada 

feedback salah dengan klik feedback salah → add componen → animator. 

 
24. Pada controller animator feedback salah klik lingkaran kecil, kemudian pilih 

animator dari animasi feedback benar. 
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25. Non aktifkan feedback benar dan salah dengan menghilangkan checklist. 

 
26. Buat C# Script dengan klik kanan assets → create → C# script → ubah nama 

dengan jawab. 

 
27. Ketikkan script berikut: 

using System.Collections; 

using System.Collections.Generic; 

using UnityEngine; 

using UnityEngine.UI; 

 

public class jawab : MonoBehaviour 

{ 

 public GameObject feed_benar, feed_salah; 

    // Start is called before the first frame update 

    void Start() 

    { 

 

    } 

    public void jawaban(bool jawab){ 

     if (jawab){ 

      feed_benar.SetActive(false); 

      feed_benar.SetActive(true); 

      int skor = PlayerPrefs.GetInt("skor")+10; 

      PlayerPrefs.SetInt("skor", skor); 

     }else{ 

      feed_salah.SetActive(false); 

      feed_salah.SetActive(true); 

     } 

gameObject.SetActive(false); 

        

transform.parent.GetChild(gameObject.transform.GetSiblingI

ndex() + 1).gameObject.SetActive(true); 

    } 

 

    // Update is called once per frame 
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    void Update() 

    { 

         

    } 

} 

 

28. Klik soal_1 kemudian masukkan script jawab dengan drag and drop. 

 
29. Masukkan feed_benar dengan objek feedback benar dan feed_salah dengan 

objek salah menggunakan drag and drop. 

 
30. Tambahkan onclick pada tombol jawaban dari A-B kita. Kemudian drag and 

drop objek soal_1 ke dalam onclik. 

 

Drag and drop 

Drag and drop 
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31. Klik no function → jawab → jawaban (bool). 

 
32. Klik objek jawaban yang benar kemudian tambahkan checklist. Jawaban salah 

tidak perlu di checklist. 

 
33.  Buat script baru dan beri nama skor, kemudian ketikan script berikut: 

using System.Collections; 

using System.Collections.Generic; 

using UnityEngine; 

using UnityEngine.UI; 

 

public class skor : MonoBehaviour 

{ 

    // Start is called before the first frame update 

    void Start() 

    { 

        PlayerPrefs.SetInt("skor",0); 

    } 

 

    // Update is called once per frame 

    void Update() 

    { 

      GetComponent<Text>().text = 

PlayerPrefs.GetInt("skor").ToString(); 

    } 

} 

34. Masukkan script skor ke dalam objek skor dengan drag and drop seperti script 

sebelumnya. 
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35. Tambahkan sound pada feedback dengan cara add component → audio 

source. 

 
36. Masukkan sound benar kedalam audio source benar. Masukkan juga sound 

salah ke dalam audio source salah. 
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37. Untuk soal kedua, duplikat dari soal_1 kemudian matikan soal_1 dan ubah 

pertanyaan dan jawaban dari soal pertama menjadi pertanyaan dan jawaban 

soal kedua. Jangan lupa checklist onclik pada jawaban yang benar. 

 
38. Aktifkan soal_1 dan nonaktifkan soal_2. 

39. Pindahkan label di atas soal_1. 

 
40. Untuk penutup soal tambahkan text di dalam canvas dengan klik kanan canvas 

→ UI → Text. 

 
41. Matikan text dan soal_2, kemudian nyalakan soal_1. 

42. Game siap dimainkan. 
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Buatlah sebuah kuis pilihan ganda sesuai dengan kreasi masing-masing. 

  

4.4 Tugas  
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Lembar Jawab 

Nama : 

NPM : 

No: Tanda tangan : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

TTD Dosen/Asisten & Tanggal  
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MODUL V 

GAME PECAH BALON 

 

 

 

Membuat game pecah balon.  

 

 

Mahasiswa mampu membuat game pecah balon dengan Unity untuk sebuah materi 

pembelajaran. 

 

 

Langkah membuat game pecah balon adalah sebagai berikut: 

1. Buat game baru dengan nama pecah balon. 

2. Masukkan file-file yang diperlukan dengan import. 

 
 

3. Buat folder baru dengan nama animasi, script dan scene  di dalam assets, dengan 

klik kanan assets → create → folder. 

 

5.1 Tujuan Pembelajaran 

5.2 Capaian Pembelajaran 

5.3 Materi 
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4. Buka folder scene kemudian buat scene baru dengan klik kanan → create → 

scene → ubah nama menjadi pecah balon. 

 
 

5. Masuk kedalam scene pecah balon kemudian masukkan background dan ubah 

position Z menjadi 5. 

 
6. Atur pivot untuk balon dengan cara pecah gambar lebih dulu dengan slice, 

kemudian atur pivot balon di tali yang paling bawah → apply. 

 
 

7. Masukkan gambar skor dengan drag and drop  kemudian ubah namanya 

menjadi skor. 
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8. Buat objek baru dengan klik kanan → create empty → ubah nama menjadi  

balon_1. 

 
 

9. Masukkan balon pertama dedalam objek balon_1, ubah nama balon pertama 

dengan nama balon dan sesuaikan ukurannya. 

 
10. Duplikat balon_1 dan ubah menjadi balon_2. 
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11. Replace balon pertama yang ada di dalam balon_2 menjadi balon kedua dengan 

drag and drop gambar balon. 

 
 

12. Lakukan hal yang sama pada balon_3. 

13. Masukkan gambar gelembung ke dalam balon_1 dengan drag and drop 

kemudian atur posisinya. 

 
14. Duplikat gelembung dengan ctrl+D dan masukkan ke dalam objek balon yang 

lainnya. 

drag and drop 
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15. Non aktifkan ketiga gelembung untuk mempermudah pengeditan dengan 

hilangkan checklist dari ketiga gelembung. 

 
 

16. Buat text di bawah balon_3 dengan klik kanan→ UI→ text. 

 
17. Atur canvas agar lebih pas dengan kamera utama, klik canvas → ubah render 

mode menjadi sreen space. 
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18. Drag and drop main camera ke dalam render camera. 

 
19. Ubah lagi render mode menjadi world space. 

 
20. Naikkan order layer menjadi 1. 
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21. Masukkan canvas ke dalam balon_1 dengan drag and drop. 

 
22. Klik text → Edit text dan buat huruf A dengan warna putih, kemudian 

letakkan pada balon pertama. 

 
 

 

23. Duplikat canvas ke dalam balon_2 dan balon_3, kemudian ubah huruf menjadi 

huruf B dan C. 
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24. Masukkan semua canvas kedalam objek balon masing-masing. 

 
 

25. Non aktifkan semua balon, kemudian aktifkan gelembung untuk 

mempermudah pengeditan. 

 
26. Duplikat masing-masing canvas, kemudian masukkan ke dalam masing-

masing objek gelembung dan ubah warna text. 
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27. Jika semua sudah di edit, maka kita non aktifkan lagi ketiga gelembung dan 

mengaktifkan ketiga balon untuk mempermudah pengeditan. 

 
28. Masukkan text ke dalam skor dengan klik kanan skor → UI→ text kemudian 

tempatkan posisinya. Isikan 0 pada text. 

 
29. Buat popup dengan membuat objek baru klik kanan → create empty, ubah nama 

menjadi hasil bermain. 
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30. Masukkan pop up gambar ke dalam objek hasil bermain kemudian naikkan 

order on layer menjadi 2. 

 
 

31. Tambahkan text di dalam objek hasil bermain dengan klik kanan objek hasil 

bermain → UI → text. Naikkan juga order in layer canvas menjadi 3. 

 
32. Edit text dan atur posisinya. 

 
33. Duplikat text dalam canvas kemudian ubah namanya menjadi skor. 
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34. Edit text, dan atur posisinya. 

 
 

35. Tambahkan button untuk restart dari game dengan cara klik kanan → UI → 

button. Selanjutnya edit text button. 

 
 

36. Matikan objek hasil bermain agar lebih mudah dalam pengeditan. Kemudian 

buat animasi balon_1. Klik balon_1 → ctrl+6→ create→ masuk ke folder 

animasi→ beri nama “balon muncul” → save. 

37. Klik add properti → transform → klik tanda + pada scale. 
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38. Tambahkan keyframe pada tengah-tengah, kemudian scale pada keyframe 

pertama ubah menjadi 0. 

 
 

39. Tambahkan animator di dalam balon_2 dan balon_3 dengan add component 

→ animator. 
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40. Ambil animasi dari balon_1, klik lingkaran kecil pada conttroller → kemudian 

pilih yang balon_1. 

 
 

41. Klik windows → animation→ animator → klik 2 x animasi “balon muncul” 

dan hilangkan check list loop time. 
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42. Buat objek baru dan beri nama bank balon, di dalam bank balon buat objek baru 

dan beri nama balon huruf (1). 

 
 

43. Masukkan balon_1 sampai balon_3 kedalam balon huruf (1). 

 
 

44. Sebelumnya tambahkan asset feed back. 
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45. Buat objek baru dan beri nama feed. 

 
 

46. Masukkan feedback benar dan salah, kemudian atur order in layer menjadi 3. 

 
 

47. Kemuadian buat animasi salah dengan klik salah → ctrl +6 → create → beri 

nama animasi salah → save. 

48. Klik add property → transform→ klik tanda + pada scale → buat 4 key frame 

dan ubah ukuran scale X dan Y keyframe pertama dan terakhir menjadi 0. 
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49. Tambahkan animator pada objek salah, kemudian matikan looptime kedua 

animasi tersebut. 

 
 

50. Dalam masing-masing balon tambahkan box collider dengan klik add 

component box collider, kemudian atur offest dan size agar sesuai dengan 

masing masing balon. 
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51. Masuk kedalam folder script → buat script baru > klik kanan → crete → C# 

Script → beri nama jawab kemudian ketikkan script berikut: 
using System.Collections; 

using System.Collections.Generic; 

using UnityEngine; 

 

public class jawab : MonoBehaviour 

{ 

    public GameObject gelembung, salahbenar, salahsalah; 

    public bool benar ;// Start is called before the first

 frame update 

    void Start() 

    { 

         

    } 

    void OnMouseUp(){ 

        gelembung.SetActive(true); 

        Destroy(gameObject);  

        if (benar){ 

            salahbenar.SetActive(false); 

            salahbenar.SetActive(true); 

        }else{ 

            salahsalah.SetActive(false); 

            salahsalah.SetActive(true); 

        } 

    } 

 

    // Update is called once per frame 

    void Update() 

    { 

         

    }} 
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52. Masukkan script jawab ke dalam masing-masing balon. Masukkan gelembung 

ke dalam masing-masing script gelembung dan salah ke salahsalah, benar ke 

salahbenar. Cheklist benar jika jawaban benar. 

 
 

53. Duplikat balon huruf 1 dan ubah menjadi balon huruf 2, kemudian ganti 

huruf-huruf di dalam balon. 

 
54. Buka folder script kemudian tambahkan script dengan nama bank_soal. 

Ketikkan script berikut: 
using System.Collections; 

using System.Collections.Generic; 

using UnityEngine; 

 

public class bank_soal : MonoBehaviour 

{ 

    public GameObject hasil_bernain; 

    int urutan=0; 
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    // Start is called before the first frame update 

    void Start() 

    { 

      set_balon();   

    } 

 

    public void control (int i){ 

        if(urutan < transform.childCount-1){ 

            urutan +=i; 

        }else{ 

            hasil_bernain.SetActive(true); 

        } 

set_balon();   

    } 

 

    public void set_balon(){ 

        for(int i = 0; i< transform.childCount; i++){ 

            transform.GetChild(i).gameObject.SetActive(tru

e); 

        } 

    } 

 

    // Update is called once per frame 

    void Update() 

    { 

         

    } 

} 

 

55. Buat script baru lagi dan beri nama feed. Ketikkan script berikut: 

using System.Collections; 

using System.Collections.Generic; 

using UnityEngine; 

 

public class feed : MonoBehaviour 

{ 

    public GameObject bank_soal,skor; 

    // Start is called before the first frame update 

    void Start() 

    { 

         

    } 

 

    public void feedback(){ 

        bank_soal.GetComponent<bank_soal>().control(1); 

        if(gameObject.name=="benar"){ 

            skor.GetComponent<skor>().score +=10; 

        } 
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    } 

 

    // Update is called once per frame 

    void Update() 

    { 

         

    } 

} 

 

56. Masukkan script bank soal ke objek bank balon kemudian masukkan hasil 

bermain ke dalam scriptnya. 

 
 

57. Masukkan script feed ke dalam objek feed, kemudian masukkan bank balon ke 

dalam bank_soal. 

 

 
 



97 

 

 

58. Buat script baru dengan nama skor. Ketikkan script berikut: 
using System.Collections; 

using System.Collections.Generic; 

using UnityEngine; 

using UnityEngine.UI; 

 

public class skor : MonoBehaviour 

{ 

    public GameObject skor_akhir; 

    public int score; 

    // Start is called before the first frame update 

    void Start() 

    { 

         

    } 

 

    // Update is called once per frame 

    void Update() 

    { 

        GetComponent<Text>().text = score.ToString(); 

        skor_akhir.GetComponent<Text>().text = score.ToStr

ing(); 

    } 

} 

 

59. Masukkan script skor kedalam text skor, kemudian class skor akhir masukkan 

skor yang terdapat di dalam objek hasil bermain. 

 
 

60. Game siap dimainkan. 

 

 

Buatlah sebuah game pecah balon  untuk suatu materi pembelajaran sesuai dengan 

kreasi masing-masing. 

  

5.4 Tugas  
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Lembar Jawab 

Nama : 

NPM : 

No: Tanda tangan : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

TTD Dosen/Asisten & Tanggal  
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MODUL VI 

GAME TEBAK HURUF 

 

 

 

Membuat game tebak huruf. 

 

 

Mahasiswa mampu membuat game tebak huruf dengan Unity untuk sebuah materi 

pembelajaran. 

 

 

Langkah membuat game tebak huruf adalah sebagai berikut: 

1. Buat project baru dengan  template 2D, beri nama dengan “Game Tebak 

Huruf”, serta pilih lokasi untuk menyimpan game tersebut. 

2. Klik Create Project. 

3. Tunggu sampai proses selesai, jika sudah selesai akan muncul tampilan 

seperti berikut. 

 

 

6.1 Tujuan Pembelajaran 

6.2 Capaian Pembelajaran 

6.3 Materi 
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4. Switch Platform ke Android dengan cara masuk pada menu File → Build 

Settings → Android → Switch Platform. Tujuannya adalah untuk mengubah 

mode pengembangan menjadi Platform Android,  agar aplikasi yang 

dihasilkan dapat berjalan di perangkat Android. Jika belum bisa melakukan 

langkah ini, maka tutorial tetap bisa dilakukan dengan mengabaikan 

langkah ini dan bisa lanjut ke langkah berikutnya.  

 

5. Download aset game pada link berikut: (https://bit.ly/asetgame)  

6. Buat beberapa folder seperti pada gambar dibawah untuk menyimpan file 

yang dibutuhkan. Klik kanan pada tab Assets → Create → Folder. Buat 

empat folder seperti pada gambar dibawah.  

    

 

 

1 

2 

3 

4 

https://bit.ly/asetgame
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7. Klik kanan pada folder Aset2D → Import New Assets lalu pilih file aset 

game yang sudah di download pada langkah sebelumnya, atau seleksi semua 

aset yang diperlukan pada folder lalu drag and drop pada tab Assets dalam 

Unity. 

  

8. Buatlah Scene baru dengan klik kanan pada folder Scene → Create → 

Scene.  

  

 

 

 

 

Langkah 1 Langkah 2 
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9. Ubah nama scene menjadi “Awal” lalu double klik untuk masuk ke scene 

Awal tersebut. Pada scene awal ini digunakan sebagai halaman awal 

sebelum game dimulai.  

 

10. Tambahkan UI Image dengan cara klik kanan pada Hierarchy → UI → 

Image. Rubah namanya dengan BG.  
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11. Klik gameobject BG lalu pada menu inspector, atur anchor preset seperti 

pada gambar, lalu atur nilai rect transform menjadi 0. Tujuannya untuk 

membuat gameobject BG menyesuaiakan ukuran canvas.  

 

12. Ganti warna putih pada gameobjek BG dengan desain pada folder aset. Klik 

BG lalu drag and drop file “frame1” kedalam source image pada menu 

inspector.  

 

1 

2 

3 

4 
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13. Masuk pada folder Aset 2D, lalu potong beberapa aset gambar. Tujuanya 

untuk memisahkan gambar sehingga menjadi sprite terpisah. Terakhir, klik 

tombol Sprite Editor.  

 

Seleksi objek feedback Hebat lalu klik tombol Trim, lakukan hal yang sama 

pada semua objek lalu klik tombol Apply. Hasilnya, gambar feedback akan 

menjadi 5 objek terpisah. Lakukan hal yang sama pada aset btn_jawab, font 

dan result.  
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Hasil akirnya, semua objek pada folder Aset 2D menjadi objek terpisah.  
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14. Tambahkan UI Image lagi lalu ganti namanya menjadi Logo. Lalu atur 

sesuai pada gambar dengan cara seperti pada langkah 12.  

 

 

15. Tambahkan UI Button lalu ganti dengan desain yang ada pada folder aset. 
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16. Tambahkan gameobjek kosong seperti pada gambar, lalu ganti namanya 

menjadi “Btn_Manager”. 

  

17. Buat Script baru pada folder script lalu ganti namanya menjadi 

“btn_manager”.  

  

18. Buka script btn_manager lalu masukan kode berikut: 

using System.Collections; 
using System.Collections.Generic; 
using UnityEngine; 
using UnityEngine.SceneManagement; 
 
public class btn_manager : MonoBehaviour { 
 
    // Use this for initialization 
    public void LoadScene (string NamaScene) { 
        SceneManager.LoadScene (NamaScene); 
    } 
    public void Keluar (){ 
        Application.Quit (); 
        Debug.Log ("Berhasil Keluar"); 
    } 
}  
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19. Kembali ke Unity, drag and drop file script btn_manager kedalam 

gameobjek Btn_Manager.  

 

20. Klik Btn_Masuk lalu tambahkan fungsi On Click pada menu inspector, lalu 

drag and drop file Btn_Manager kedalam fungsi On Click tersebut. 

  

 

 

 

 

 

1 

2 
3 
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21. Klik No Function → btn_manager → LoadScene (string). Masukan nama 

scene tujuan dari tombol masuk tersebut.  

  

22. Masuk ke folder scene lalu buat scene baru dengan nama “Gamplay” sesuai 

dengan nama yang diisi pada fungsi On Click sebelumnya.  

 

23. Masuk ke scene Gamplay lalu atur UI seperti pada gambar. Drag and drop 

aset frame 2 kedalam hierarchy lalu ganti namanya menjadi “BG”. 
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24. Tambahkan gameobjek kosong dengan nama “Soal”, lalu tambahkan 

gameobjek kosong lagi dengan nama “Soal 1” dengan cara klik kanan pada 

gameobjek Soal lalu create empty. Tujuannya adalah agak gameobjek Soal 

1 menjadi anak dari gameobjek Soal. 

 

25. Pada Soal 1, tambahkan UI Image lalu ganti namanya menjadi “A”. 

Selanjutnya tambahkan UI Text lalu ganti namanya menjadi “Text”. Atur 

Canvas seperti pada gambar. 

 

Lalu atur posisi dan ukurannya objek A dan Text seperti pada gambar 
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26. Klik A lalu ganti dengan desain huruf A pada folder Aset 2D 

 

27. Pada gameobjek text, masukan teks soal seperti pada gambar. 

 

Scale 

X,Y,Z 

= 8 

F 
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28. Tambahkan gameobjek kosong (create empty) lalu ganti namanya menjadi 

Btn_Jawab lalu atur ukurannya seperti pada gambar.  

 

 

 

 

 

 

 

 

 



113 

 

29. Tambahkan komponen Grid Layout Group pada Btn_Jawab. 

 

Atur nilainya seperti pada gambar 

 

 

30. Tambahkan 4 buah UI Image pada Btn_Jawab lalu ganti nama dan 

desainnya seperti pada gambar. Atur ukuran scale Jawaban_A,B,C dan D 
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31. Tambahkan gameobjek kosong (create empty) lalu ganti namanya menjadi 

“FeedBack”. Tambahkan 2 UI Image lalu ganti namanya menjadi 

“feedback-benar” dan “feedback-salah”. Atur scale X,Y = 0.1. 

Scale 

X= 1.2 

Y= 1.2 
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32. Ganti desain feedback-benar dan salah dengan desain pada folder Aset 2D. 

 

33. Tambahkan animasi pada feedback-benar dengan cara klik feedback-benar 

→ masuk tab animation → Create → cari folder Animasi → berinama 

“Feedback” → Save.  

  



116 

 

34. Buka timeline animation lalu tambahkan animasi scale pada gameobjek 

feedback-benar. Pastikan klik gameobjek feedback-benar → pada tab 

animation, nyalakan keyframe record  untuk merekam animas. 

 

Lalu masukan nilai scale seperti pada tabel: 

Frame Nilai Scale 

00:00 X= 0 || Y= 0 

00:20 X= 0.11 || Y= 0.11 

00:30 X= 0.1 || Y= 0.1 

00:40 X= 0.11 || Y= 0.11 

00:50 X= 0.1 || Y= 0.1 

1:00 X= 0 || Y= 0 
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35. Selanjutnya masuk pada tab animator, jika tidak ada, maka cari di menu 

Window → Animator. 

 

 

36. Klik 2x Feedback untuk mematikan Loop Time nya 

 

37. Klik feedback-salah lalu tambahkan kompenen animator. 

 

Double Klik 

Hilangkan 

centang Loop 

Time 
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38. Masuk ke folder Animasi lalu drag and drop file animasi feedback-benar 

kedalam Controller Animator feedback-salah 

 

Lalu nonaktifkan gameobjek feedback-benar dan feedback-salah 

 

 

39. Create Empty lalu rubah namanya menjadi GameOver, lalu tambahkan 2 UI 

Image dengan nama Image dan papan. Selanjutnya tambahkan UI Button 

lalu ganti namanya dengan Btn_Repeat dan Btn_Home. Atur ke empat 

gameobjek tersebut sepeti pada gambar. 
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Pada gameobjek Image, klik surce image lalu tekan delete pada keyboard 

lalu ganti warnya menjadi hitam dengan opacity 200. 

 

Pada gameobjek Papan, atur Order In Layer menjadi 3, agar papan berada 

di depan Image.  

Klik lalu 

tekan Delete 
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Klik GameOver lalu nonaktifkan 

 

40. Masuk pada folder Script lalu buat C# script baru dengan nama “Jawab”.  

 

Masukan kode berikut: 

using System.Collections; 
using System.Collections.Generic; 
using UnityEngine; 
 
public class Jawab : MonoBehaviour { 
    public GameObject FeedbacBenar, FeedbackSalah; 
    public bool Benar; 
    // Use this for initialization 
    void OnMouseUp(){ 
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        if (Benar) { 
            FeedbacBenar.SetActive (false); 
            FeedbacBenar.SetActive (true); 
        } else { 
            FeedbackSalah.SetActive (false); 
            FeedbackSalah.SetActive (true); 
        } 
    } 
 
}  

 

 

41. Masukan script Jawab kedalam Jawaban_A, B, C dan D. Pastikan 

Jawaban_A, B, C dan D terseleksi semua lalu drag and drop gameobjek 

feedback-benar dan salah kedalam inspector 

 

Karena jawaban yang benar adalah Apel (Jawaban_B) maka klik gameobjek 

Jawaban_B lalu centang pada kolom Benar 
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42. Seleksi gameobjek Jawaban_A, B, C dan D lalu tambahkan komponen Box 

Collider 2D.  

 

Isi nilainya seperti pada gambar 

 

Hasilnya kotak dengan garis hijau terdapat di empat tombol Jawaban_A, 

B, C, dan D. 

  

43. Create empty lalu rubah namanya menjadi Btn_Manager 

1 

2 

3 
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44. Masuk pada folder script lalu masukan script btn_manager kedalam 

gameobjek Btn_Manager dengan cara drag and drop. 

 

45. Seleksi Btn_Repeat dan Btn_Home, pada fungsi On Click () di inspector 

klik + lalu drag and drop gameobjek Btn_Manager kedalam fungsi On Click 

  

1 

2 

3 
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46. Masuk ke folder Script lalu buat C# script dengan nama “SoalManager”. 

Masukan script berikut: 

using System.Collections; 
using System.Collections.Generic; 
using UnityEngine; 
 
public class SoalManager : MonoBehaviour { 
    public GameObject Selesai; 
    int urutan =0; 
    // Use this for initialization 
    void Start () { 
        setSoal(); 
 
    }  
    public void kontrol (int i){ 
        if (urutan < transform.childCount -1){ 
            urutan += i; 
        } else { 
            Destroy (gameObject); 
            Selesai.SetActive (true); 
        } 
        setSoal(); 
    } 
 
    public void setSoal(){ 
        for (int i= 0; i < transform.childCount; i++ ){ 
            transform.GetChild (i).gameObject.SetActive (false
); 
        } 
        transform.GetChild (urutan).gameObject.SetActive (true
); 
    }    
}  

 

 

47. Drag and drop file script SoalManager kedalam gameobjek Soal, lalu drag 

and drop gameobjek GameOver kedalam inspector 
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48. Masuk ke folder Script lalu buat C# script dengan nama “Feed”. Masukan 

script berikut: 

using System.Collections; 
using System.Collections.Generic; 
using UnityEngine; 
 
public class Feed : MonoBehaviour { 
    public GameObject banksoal; 
    // Use this for initialization 
    public void feedback(){ 
        banksoal.GetComponent<SoalManager> ().kontrol (1); 
    } 
 
}  
 

 

49. Drag and drop script Feed kedalam gameobjek feedback-benar dan 

feedback-salah, lalu drag and drop gameobjek Soal kedalam inspector. 

1 

2 
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50. Klik feedback-benar lalu masuk ke tab animation. Tambahkan event pada 

timeline ke 1:00. 

 

 

51. Klik event lalu pada inspector pilih function “feedback” 

 

1 

2 

1 

2 

1 

2 
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52. Duplikat (Ctrl D) Soal 1 empat kali lalu rubah namanya menjadi Soal 2,3, 4 

dan 5. 

  

53. Ganti teks soal dan gambar pada tombol Jawaban_A, B, C dan D sesuai 

dengan soal. Sehingga empat soal seperti pada gambar. Atur juga jawaban 

benar untuk setiap soal (A= Apel, B= Baju, C= Cincin, D= Dasi, E= Ember). 

     

54. Tes Game 

 

 

Buatlah game tebakan dengan dengan kreasi anda sendiri. 

  

6.4 Tugas  
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Lembar Jawab 

Nama : 

NPM : 

No: Tanda tangan : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

TTD Dosen/Asisten & Tanggal  
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MODUL VII 

GAME AR PC 

 

 

 

Membuat game Augmented Reality Personal Computer.  

 

 

Mahasiswa mampu membuat game Augmented Reality Personal Computer Unity 

untuk sebuah materi pembelajaran. 

 

 

Langkah membuat game Augmented Reality Personal Computer adalah sebagai 

berikut: 

A. Konfigurasi Vuforia SDK 

Vuforia merupakan sebuah plugin yang dapat digunakan untuk membuat 

aplikasi Augmented Reality. Vuforia dapat diintegrasikan dengan game engine 

Unity 3D sebagai software pengembangan game 2D atau 3D sehingga aplikasi 

yang dihasilkan dapat dijalankan di sistem operasi android maupun iOS. 

Pembahasan ini difokuskan pada pengembangan aplikasi Augmented Reality 

sederhana yang dapat dijalankan di sistem operasi Android.  

1. Akun Vuforia 

Untuk menggunakan vuforia, terlebih dahulu daftar akun vuforia dengan 

mengunjungi situs web vuforia (https://developer.vuforia.com) kemudian 

pilih menu register.  

 

7.1 Tujuan Pembelajaran 

7.2 Capaian Pembelajaran 

7.3 Materi 

https://developer.vuforia.com/
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2. License Manager 

Setelah memiliki akun vuforia, kemudian login untuk memulai 

pengembangan. Pada menu Develop ➔ License Manager, klik tombol “Get 

Basic”. 

 

  
 

 

Kemudian akan muncul form untuk mengisi nama license key dari projek 

yang akan dikembangkan. Pada contoh tersebut menggunakan nama “AR 

PC Game” kemudian centang pada Vuforia Developer Agreement lalu klik 

tombol “Confirm”. 
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Setelah membuat license key, maka nama lisensi tersebut akan terdaftar pada 

halaman license manager.  

 
Klik nama lisensi yang sudah dibuat yaitu “AR PC Game”, maka akan 

diarahkan ke halaman license key yang digunakan untuk mengintegrasikan 

Unity dengan Vuforia.  
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ARgeho3/////AAABmWboOCSgDkzZrGNrZWJiBn87rAo3luEYDed9VbP7a24DZDsj

lpTJBEAVE66kg8NOlBc20chObghCJPF8BPPtpfy4xtioYklg47/iHNSBjJMNc0LWkC

wtfC+t3FRZXxzBT0BkuUesIpUTyW9xEado/gOITswBUmqD2YsoSnRh7JNn3iewh

YJXY3I/+CxEtkNIKGycJ1LrIfp3Ooy/IF1pd+3Xl05GAwUYFacdmGHQU8prln4GFP

ELOKOG4yMNUaw6cc1w6cJhqLbIBCOL2CHJo8XXBzG5JXn7AwrcC7khzBifkgj7

4/PYjYkPfSTi7+G5GzD1OvIlsJPpfsirY2XnlA+xtW7v8G0d2+0hCQeoI1+J 

 

3. Target Manager 

Target manager merupakan tempat pembuatan database marker yang akan 

digunakan dalam pembuatan aplikasi augmented reality. Untuk membuat 

database marker, yaitu pada menu Target Manager ➔ Add database 

    
 

 

License Key 
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Klik Database ARPCGame untuk masuk ke halaman target manager 

ARPCGame 

  
Klik Add Target lalu masukan gambar marker yang telah di download 

pada link sebelumnya.  

 
 

Marker berhasil ditambahkan. Pastikan bahwa marker yang digunakan 

memiliki rating bintang 5, sehingga marker tersebut dapat menampilkan 

objek 3D AR dengan baik. Unduh marker dengan klik tombol 
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4. Download Database lalu pilih Unity Editor sebagai development platform 

nya. 

  
5. Download Vuforia SDK. Pada tab Download → SDK → Unity (Add 

Vuforia Engine to a Unity Project or upgrade to the latest version)  

Link: https://developer.vuforia.com/downloads/sdk  

 
 

B. Langkah Pengembangan  

1. Buat project baru dengan  template 2D, beri nama dengan “AR PC GAME”, 

serta pilih lokasi untuk menyimpan game tersebut. 

2. Klik Create Project. 

3. Tunggu sampai proses selesai, jika sudah selesai akan muncul tampilan 

seperti berikut. 

https://developer.vuforia.com/downloads/sdk


135 

 

 

 

4. Switch Platform ke Android dengan cara masuk pada menu File → Build 

Settings → Android → Switch Platform. Tujuannya adalah untuk mengubah 

mode pengembangan menjadi Platform Android, agar aplikasi yang 

dihasilkan dapat berjalan di perangkat Android. Pada pembuatan AR PC 

Game ini, diwajibkan untuk switch platform ke android, karena Vuforia 

hanya mendukung untuk Android. .  

 

5. Download aset game pada link berikut: (https://bit.ly/asetgame)  

1 

2 

3 

4 

https://bit.ly/asetgame
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6. Buat lima folder seperti pada gambar untuk menyimpan file yang 

dibutuhkan. Klik kanan pada tab Assets → Create → Folder.  

    

7. Import Vuforia SDK dan Database Marker yang sudah di download pada 

link sebelumnya.  

  

Jika sudah, maka akan terdapat beberapa folder baru bawaan dari Vuforia 

SDK dan Database Marker 
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8. Klik kanan pada folder Aset2D → Import New Assets lalu pilih file aset 

game yang sudah di download pada langkah sebelumnya, atau seleksi semua 

aset yang diperlukan pada folder lalu drag and drop pada folder Aset2D 

dalam Unity. 

 

  

9. Potong gambar Btn_UI yang sudah di import sebelumnya. 
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10. Buatlah Scene baru dengan klik kanan pada folder Scene → Create → 

Scene.  

1 

2 

3 

1 

2 

3 
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11. Ubah nama scene menjadi “Awal” lalu double klik untuk masuk ke scene 

Awal tersebut. Pada scene awal ini digunakan sebagai halaman awal 

sebelum game dimulai.  

 

 

12. Tambahkan UI Image untuk background dengan nama “BG”, lalu 

tambahkan UI Button sebagai tombol mulai dengan nama “Mulai”, terakhir 

create empty untuk menyimpan script dengan nama “Btn_Mananger”. Atur 

layout scene Awal seperti pada gambar. 
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13. Buat scene baru dengan nama “AR Gameplay” sebagai scene utama untuk 

game play. Double Click untuk masuk ke scene AR Gameplay. 

 

14. Tambahkan UI Image untuk background dengan nama “BG”, lalu 

tambahkan 2 UI Button sebagai tombol kembali dan keluar program dengan 

nama “Btn_Back” dan “Btn_Close”, terakhir create empty untuk 

UI Image 

UI Button 

 

Create Empty 
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menyimpan script dengan nama “Btn_Mananger”. Atur layout scene AR 

Gameplay seperti pada gambar. 

 

15. Masuk pada folder Vuforia → Prefabs lalu drag and drop AR Camera dan 

Image Target kedalam Hierarchy 

 

16. Klik AR Camera lalu pada tab inspector klik tombol Open Vuforia 

Configuration lalu masukan copy license key yang sudah dibuat pada 

website Vuforia sebelumnya lalu paste kedalam App License Key. Pada 

Datasets, centang Load ARPCGame Database dan Active 
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17. Klik Image Target lalu pada tab inspector atur seperti pada gambar 

 

18. Masuk pada folder Aset3D lalu buat beberapa folder seperti pada gambar. 

 

19. Masukan aset 3D yang terdapat pada folder aset yang sudah di download 

sebelumnya pada masing-masing folder dalam Unity. 

20. Drag and drop 3D Objek Processor kedalam Image Target lalu atur posisi 

dan ukurannya sesui dengan ukuran marker 
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Nonaktifkan 3D objek Processor lalu masukan lagi 3D object RAM 

kedalam Image Target 

 

Nonaktifkan 3D objek RAM lalu masukan lagi 3D object Mainboard 

kedalam Image Target 
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Nonaktifkan 3D Objek Mainboard lalu aktifkan kembali 3D Objek 

Processor, sehingga tampilan akhirnya hanya 3D Objek Processor yang 

aktif. 

 

21. Creat empty lalu rubah namanya menjadi “Soal 1”. Masukan UI Text 

dengan nama “Text_Soal” sebagai soal, UI Button dengan nama 

Btn_Processor dan Btn_RAM sebagai tombol jawaban lalu atur layout nya 

seperti pada gambar. 
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22. Create empty lalu ubah namanya menjadi “Feedback”. 

 

23. Klik gameobjek Like lalu masuk pada tab animation. Klik Create lalu cari 

folder Animasi, beri nama “Feedback” lalu Save. 
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24. Buka timeline animation lalu tambahkan animasi scale pada gameobjek 

Like. Pastikan klik gameobjek Like → pada tab animation, nyalakan 

keyframe record  untuk merekam animasi.  

 

Lalu masukan nilai scale seperti pada tabel: 

Frame Nilai Scale 

00:00 X= 0 || Y= 0 

00:20 X= 3.4 || Y= 3.4 

00:30 X= 3.3 || Y= 3.3 

00:40 X= 3.4 || Y= 3.4 

s00:50 X= 3.3 || Y= 3.3 

1:00 X= 0 || Y= 0 
 



148 

 

 

25. Selanjutnya masuk pada tab animator, jika tidak ada, maka cari di menu 

Window → Animator. 

 

 

 

26. Klik 2x Feedback untuk mematikan Loop Time nya 

 

Double Klik Hilangkan centang 

Loop Time 
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27. Klik Dislike lalu tambahkan kompenen animator. 

 

28. Masuk ke folder Animasi lalu drag and drop file animasi Like kedalam 

Controller Animator Dislike 
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29. Nonaktifkan gameobjek Text_Soal, Btn_Processor, Btn_RAM, Like dan 

Dislike 

 

30. Tambahkan UI Text dengan nama “Text_deskripsi” dan UI Button dengan 

nama “Btn_NextSoal”. Atur layoutnya seperti pada gambar dibawah. 

 

31. Nonaktifkan Text_Deskripsi lalu aktifkan kembali Text_Soal, 

Btn_Processor dan Btn_RAM. 
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32. Tambahkan fungsi On Click () pada Btn_Processor dan Btn_RAM 

 

33. Klik Btn_Processor lalu drag and drop gameobjek Like kedalam fungsi 

onclick 

 

Lalu klik No Function → GameObjek → SetActive (bool) 

 

Lalu centang 
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34. Lakukan hal yang sama pada gameobjek Btn_RAM, lalu drag and drop 

gameobjek Dislike. 

 

Lalu centang 

 

35. Seleksi Btn_Processor dan Btn_RAM lalu tambahkan fungsi OnClick 

 

Lalu drag and drop Text_Deskripsi kedalam fungsi OnClick 

 

Klik No Function → GameObjek → SetActive (bool) lalu centang 
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36. Kembali seleksi Btn_Processor dan Btn_RAM lalu tambahkan 3 fungsi 

OnClick 

 

37. Tetap seleksi Btn_Processor dan Btn_RAM lalu drag and drop Text_Soal, 

Btn_Processor dan Btn_RAM itu sendiri kedalam fungsi onclick 

 

Klik No Function → GameObjek → SetActive (bool) lalu uncheck semua 
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38. Duplikat (Ctrl D) Soal 1, ganti namanya menjadi Soal 1 lalu nonaktifkan 

Soal 1 

 

39. Atur layout Soal 2 seperti pada gambar 

   

40. Duplikat (Ctrl D) Soal 2, ganti namanya menjadi Soal 3 lalu nonaktifkan 

Soal 1 dan 2. Soal 3 ini akan menjadi soal terakhir, maka ganti nama tombol 

“Btn_NextSoal” menjadi tombol “Btn_Beranda” lalu duplikat tombol 

“Btn_Beranda”, lalu ganti nama dan desainnya menjadi “Btn_Ulang” lalu 

tempatkan dibawah Btn_Beranda. 
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41. Masuk pada folder Script lalu buat C# script dengan nama Btn_Manager.  

 

Buka script Btn_Manager lalu masukan konde berikut: 

using System.Collections; 
using System.Collections.Generic; 
using UnityEngine; 
using UnityEngine.SceneManagement; 
 
public class Btn_Manager : MonoBehaviour { 
//nama class Btn_Manager harus sama dengan nama file C# nya 
 
    // Use this for initialization 
    public void LoadScene (string NamaScene) { 
        SceneManager.LoadScene (NamaScene); 
    } 
    public void Keluar (){ 
        Application.Quit (); 
        Debug.Log ("Berhasil Keluar"); 
    } 
} 

Drag and drop C# script Btn_Manager kedalam gameobjek Btn_Manager 
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42. Seleksi Btn_Beranda dan Btn_Ulang, lalu tambahkan fungsi OnClick 

 

43. Drag and drop gameobjek Btn_Manager kedalam fungsi onclick 

 
44. Klik No Function → Btn_Manager → LoadScene(String) 
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45. Klik Btn_Beranda lalu pada inspector masukan nama scene tujuan jika 

tombol Btn_Beranda di klik. Dalma hal ini, scene tujuanya nya adalah 

Scene Awal, maka tulis “Awal”. 

 

46. Klik Btn_Ulang lalu masukan nama scene tujunya nya yaitu scene AR 

Gamplay itu sendiri. 

 

47. Masuk ke folder Scene lalu klik File → Build Settings. Drag and drop scene 

Awal dan scene AR Gameplay kedalam Scenes In Build 
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48. Seleksi Btn_NextSoal dari Soal 1 dan Soal 2 lalu tambahkan 2 fungsi 

onclick 

 

49. Klik Btn_NextSoal pada Soal 1 lalu drag and drop Soal 1 dan Soal 2 

kedalam fungsi onclick 
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50. Klik No Function → GameObject → SetActive(bool), centang untuk Soal 

2. 

 

51. Klik Btn_NextSoal pada Soal 2 lalu drag and drop Soal 2 dan Soal 3 

kedalam fungsi onclick 

  

52. Klik No Function → GameObject → SetActive(bool), centang untuk Soal 

3. 
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53. Klik Btn_NextSoal pada Soal 1 lalu tambahkan 2 fungsi onclick 

 

54. Drag and drop 3D Objek Processor dan RAM kedalam masing-masing 

fungsi onclick. Klik No Function → GameObject → SetActive(bool) lalu 

centang fungsi RAM 
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55. Klik Btn_NextSoal pada Soal 2 lalu tambahkan 2 fungsi onclick 

 

56. Drag and drop 3D Objek RAM dan Mainboard kedalam masing-masing 

fungsi onclick. Klik No Function → GameObject → SetActive(bool) lalu 

centang fungsi Mainboard 

 

57. Seleksi Btn_Back dan Btn_Close, lalu tambahkan fungsi onclick 

 



162 

 

58. Drag and drop Btn_Manager kedalam fungsi onclick 

 

59. Klik Btn_Back lalu klik No Function → Btn_Manager → LoadScene 

(string). Masukan nama scene tujunnya yaitu “Awal”. 
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60. Klik Btn_Close klik No Function → Btn_Manager → Keluar () 

 

61. Terakhir, aktifkan Soal 1 dan nonaktifkan Soal 2 dan 3. 

 

62. Tes Game 

 

 

 

Buatlah game AR lain dengan materi yang berbeda atau dengan penggunaan 

multimarker (setiap objek memiliki marker tersendiri). 

  

7.4 Tugas  
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Lembar Jawab 

Nama : 

NPM : 

No: Tanda tangan : 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

TTD Dosen/Asisten & Tanggal  
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